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Resumo 
O Brasil é composto por 5570 municípios dos quais, segundo o IBGE, 4074 possuem menos de 20.000 

habitantes. De maneira mais específica o IBGE ainda apresenta que 1382 municípios possuem menos de 5.000 

habitantes. A grande maioria destes municípios carecem de metodologias que ofereçam soluções a baixo custo 

voltadas ao levantamento e atualização cadastral das Unidades Imobiliárias (UI’s) municipais. Nesse cenário são 

pouco explorados os recursos tecnológicos eficientes e a baixo custo que permitem monitorar a dinâmica da 

cidade e reconhecer o seu comportamento. A experiência na atualização dos dados cadastrais imobiliários mostra 

um aumento das UI’s, e um novo enquadramento do município, com potencial de arrecadação do Imposto 

Predial e Territorial Urbano (IPTU). Os softwares livres podem prover aos gestores públicos/prefeituras os 

recursos demandados para o cadastramento eficiente das UI’s, tornando-se financeiramente viável. O artigo 

apresenta os procedimentos metodológicos desenvolvidos para gerar o cadastramento das UI’s do município de 

Botuverá/SC, a partir da customização do aplicativo gratuito chamado Cybertracker. O software foi 

customizado, conforme demandas da prefeitura e inserido em um tablet, o qual permitiu executar o levantamento 

dos dados relativos às UI’s, reproduzindo de modo eficiente o Boletim de Informações Cadastrais (BIC). Como 

resultado, obteve-se um banco de dados atualizado das UI’s georreferenciadas, contendo a caracterização física 

das UI’s, coordenadas geográficas e fotografia digital da fachada. 

 

Palavras chaves: Atualização cadastral, Unidades imobiliárias, Município pequeno, IPTU. 
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Abstract 
Brazil consists of 5.570 municipalities, 4.074 of which have less than 20.000 inhabitants, according to IBGE. 

More specifically, IBGE still shows that 1.382 municipalities have less than 5,000 inhabitants. The vast majority 

of these municipalities lack methodologies that offer low cost solutions for the cadastral survey and updating of 

Municipal Real Estate Units. In this scenario, the efficient and low cost technological resources, which allow the 

monitoring of the city’s dynamics and recognition of its behavior, are little explored. The experience on updating 

the Real Estate registration data shows a rise in the units, and a new settlement of the municipality, with the 

potential of collecting Building and Urban Land Tax (property tax). Free software may provide to Public 

Managers/city halls the resources needed for the Efficient registration of the units, making it financially viable. 

The article presents the methodological procedures developed to generate registration of the units in the 

municipality of Botuverá/SC, from the customization of the free application called CyberTracker. The software 

was customized, according to the demands of the city and inserted into a tablet, which allowed the collection of 

data related to the unit, reproducing in an effective way the Cadastral Information Bulletin. As a result, an 

updated database of the georeferenced units was obtained, containing the physical characterization of the units, 

geographical coordinates and digital photography of the facade. 

 

Keywords: Cadastral update, Real estate units, Small City, Property tax. 
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1 INTRODUÇÃO 

 

Mediante a falta da real representação dos dados cadastrais imobiliários, seja por 

ineficiência no método ou desatualização do banco de dados, verifica-se a necessidade de 

desenvolvimento de métodos de coleta e sistematização eficiente de dados geográficos 

imobiliários. De fato, tem-se associado a essa realidade uma diminuta receita orçamentária na 

maioria dos municípios brasileiros de pequeno porte, bem como pouco ou nenhum 

investimento em tecnologias destinadas ao controle imobiliário, não correspondendo muitas 

vezes à proporção demandada pela expansão dinâmica, ao número de edificações e parcelas 

territoriais. O Município de Botuverá, localizado no médio Vale do Itajaí, em Santa Catarina, 

tem uma população aproximada de 4.785 habitantes e ilustra neste trabalho a situação 

cadastral brasileira dos pequenos municípios. Ressalta-se que no início do projeto a Prefeitura 

de Botuverá não dispunha de um controle efetivo e atualizado das informações cadastrais das 

unidades imobiliárias, bem como de nenhum documento cartográfico de base, além de utilizar 

formulários impressos para realizar o levantamento cadastral imobiliário.  

Os municípios de pequeno porte dependem do fundo de participação dos municípios e 

estes só sobrevivem por meio do repasse de verba do Governo Federal, logo, percebe-se quão 

“limitada” é a administração municipal uma vez que não apresenta capacidade e meios de 

arrecadação. 

Ciente dessa realidade, a academia estuda novas metodologias que permitam executar, 

de modo eficiente, o levantamento e a atualização cadastral das unidades imobiliárias 

viabilizando, por meio da associação de dados alfanuméricos com referência espacial 

(geográfico), a implantação e gestão do sistema eficiente de arrecadação para esses 

municípios.  

Novos aplicativos tecnológicos disponíveis para o uso em smartphones ou tablets, que 

se utilizam das coordenadas obtidas com Global Positioning System (GPS) e permitem a 

vinculação de formulários digitais, têm despertado o interesse da comunidade científica. O 

objetivo no desenvolvimento dos aplicativos visa explorar a utilização de software de Sistema 

de Informações Geográficas (SIG), em especial no potencial de coleta e gerenciamento de 

dados geográficos. No entanto, em função do investimento demandado inicialmente 

(principalmente na aquisição de licenças de softwares) associado aos insumos envolvidos para 

ser executado em um levantamento cadastral de unidades imobiliárias, muitos municípios 

acabam por não utilizar os recursos (geo)tecnológicos que poderiam otimizar/aperfeiçoar o 

processo de cadastramento, atualização e consulta de dados. 

Apesar de Botuverá ser considerado um município pequeno, nacionalmente ele é 

conhecido por possuir a maior gruta do Sul do Brasil com 296 km² de área, possui uma 

densidade demográfica de 15 hab./km² e apresentou em 2013 uma população estimada de 

4.785 habitantes (IBGE, 2014a). Salienta-se que mesmo com esse perfil o município 

apresenta uma dinâmica intensa e, portanto, utilizar-se de recursos (geo)tecnológicos para 

reconhecer o território é fundamental.  

Assim, com a constante desatualização das bases cadastrais imobiliárias municipais o 

Estado e municípios são prejudicados não somente por não arrecadar, mas também por não 

definir uma política de tributação que contemple a equidade fiscal. Por correlação tem-se 

claro que “só se administra e planeja o que se conhece” e não tendo disponível um banco de 

dados imobiliário atualizado e confiável a administração pública local não consegue tomar 

ações de gerenciamento e ordenamento territorial eficiente.  

Entre os produtos cartográficos comumente demandados pelas prefeituras e estados 

brasileiros estão os provenientes da aerofotogrametria, cujo emprego ocorre para fins de 
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auxílio ao controle cadastral imobiliário, atualização na base de dados para concessionárias, 

planejamento local ou regional, auxílio nas políticas públicas, entre outros. Em 2010, o Estado 

de Santa Catarina adquiriu aerofotografias ortorretificadas com resolução de 0,39 cm e 

compatíveis com a escala 1:10.000, porém, desde que a Prefeitura de Botuverá recebeu os 

dados em junho de 2013 não houve uso efetivo destes dados cartográficos. Verifica-se que a 

dificuldade encontra-se na falta de estrutura do órgão público para trabalhar os dados 

cartográficos em meio digital, capacitação e atualização da equipe técnica da prefeitura e em 

especial orientação em como explorar o potencial dos dados cartográficos visando o efetivo 

reconhecimento e gestão territorial em prol do município.  

A parceria da Prefeitura Municipal de Botuverá com a UDESC – Universidade do 

Estado de Santa Catarina, por meio do Laboratório de Geoprocessamento (GeoLab), 

viabilizou um trabalho conjunto de orientação e capacitação técnica que permitiu a geração da 

cartografia temática no município e a atualização do banco de dados cadastral imobiliário. 

Porém, foi necessário primeiramente conhecer a demanda emergencial do município e 

fornecer subsídios tecnológicos aos gestores públicos, que por meio de consultas diretas aos 

cadastros digitais das unidades imobiliárias municipais pudessem visualizar a real situação 

das condições do imóvel municipal, seja por meio de fotografias digitais ou consultas às 

planilhas eletrônicas descritivas. 

Como aporte tecnológico foi definido para o Município de Botuverá a aplicação do 

software Cybertracker que foi desenvolvido em 1996 pelo criador da organização sem fins 

lucrativos Cybertracker Conservation, Louis Liebenberg, e o cientista da computação, Justin 

Steventon. O software foi desenvolvido para ser utilizado como uma ferramenta de rastreio e 

monitoramento da fauna do sudeste da África, a partir da participação de comunidades 

indígenas locais, as quais detêm grande habilidade para a caça e vasto conhecimento 

geográfico, facilitando, deste modo, o controle de espécies locais. Por meio de seu objeto de 

pesquisa (fauna africana), Liebenberg envolveu cientistas, comunidades locais (Figura 11) e a 

tecnologia espacial a fim de salvaguardar as áreas prioritárias da biodiversidade. Conforme os 

dados da entidade, mais de 50 mil pessoas utilizam o software em 210 países. 

 

 
Figura 1 – Indígena da tribo Karoha (sudeste da África) manipulando um PDA com o 

aplicativo Cybertracker.  

Fonte: http://www.cybertracker.org/background/our-story 

 

Preto et al. (2011) identificaram e avaliaram as formas de representação das percepções 

de risco de crianças e adolescentes por meio dos Sistemas de Informação Geográfica 

Participativo (SIG-P) e de um PDA (Personal Digital Assistant) com o aplicativo 

Cybertracker para associar as coordenadas geográficas e integrar diferentes alternativas de 

percepções de risco. 

Peters-Guarin e McCall (2010; 2011) destacam a simplicidade operacional, a variedade 

de recursos e a possibilidade do uso em smartphones como algumas das características mais 
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importantes presentes no aplicativo Cybertracker, aplicação esta empregada pelos autores, em 

conjunto com imagens orbitais oriundas do aplicativo Google Earth, em duas comunidades do 

município de Michoacán, México, para fins de mapeamento e inventário fitossociológico e 

social de áreas potenciais destinadas ao estabelecimento das práticas de crédito de carbono.  

Kennedy (2012) salienta que em função da evolução dos aplicativos para smartphones, 

inúmeros recursos que vêm a possibilitar a coleta e disseminação dos dados espaciais na 

modalidade crowdsourcing (colaboração voluntária) têm sido criados e disponibilizados na 

internet, tais como àqueles contidos no Cybertracker. 
 

2 MÉTODO 

 

Os procedimentos descritos a seguir detalham as principais características operacionais 

relacionadas ao software e aplicativo Cybertracker, bem como apresenta cada uma das opções 

contidas no BIC – Boletim de Informações Cadastrais do Município de Botuverá, de acordo 

com a metodologia desenvolvida pela Prefeitura para coleta de dados em meio analógico 

(planilhas papel). 

A equipe da Prefeitura participante do projeto foi composta por quatro técnicos, sendo 

dois coordenadores e duas estagiárias, as quais foram responsáveis por realizar o 

levantamento e descarregamento dos dados das unidades imobiliárias da área ainda não 

cadastrada em um prazo de um mês e meio.  

Previamente capacitadas pela equipe do GeoLab, as técnicas da prefeitura visitaram as 

unidades in loco, tendo em mãos o equipamento tablet, a relação de mapas (impressos) em 

grande escala com identificação das edificações (unidade imobiliárias) a serem levantadas e 

ainda uma planilha contendo os códigos das edificações utilizada para realizar a validação em 

campo. 

A equipe técnica responsável pelo desenvolvimento do projeto em escritório faz parte 

do Laboratório de Geoprocessamento (GeoLab) da UDESC e teve a responsabilidade de: 

a) Preparar o material para saída a campo a partir das ortofotos obtidas pelo Estado de Santa 

Catarina e repassadas ao município; 

b) Gerar o sistema de codificação das unidades imobiliárias para gerenciamento do banco de 

dados no Software SIG – objetivando posterior vinculação aos dados preexistentes na 

prefeitura; 

c) Customizar o software Cybertracker na plataforma tablet – em acordo com o BIC; 

d) Interpretar e digitalizar as edificações visíveis nas ortofotos em especial fazendo a 

vinculação dos dados levantados com os dados gráficos; 

e) Gerenciar, atualizar e sistematizar o banco de dados referente as unidades imobiliárias do 

município de Botuverá. 

 

Ressalta-se que a atividade prioritária acordada pela equipe técnica da UDESC e 

Prefeitura de Botuverá foi a construção e atualização do banco de dados das unidades 

imobiliárias. Nesse sentido, o maior destaque no método apresentado nesse artigo refere-se ao 

uso e aplicação do software Cybertracker. Portanto, têm-se na sequencia uma orientação 

técnica das etapas (passo a passo) para o desenvolvimento do trabalho de levantamento dos 

dados cadastrais imobiliários e, por conseguinte, a aplicação do Cybertracker na plataforma 

tablet.  

 

2.1 Download e Instalação do Cybertracker no computador 

 

Faça o download e instale o software Cybertracker – Disponível em: 

http://www.cybertracker.org/software/free-download. 

http://www.cybertracker.org/software/free-download
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2.2 Copiando o arquivo MDB para o computador 

 

Crie uma pasta denominada “BIC_Botuvera” no computador definido para receber os 

dados do Tablet e copie o arquivo com o nome “BIC-Botuvera_20140114.MDB” para a pasta 

criada. Deve-se utilizar apenas 1 (um) computador para descarregar os dados oriundos do 

tablet. O software Cybertracker não permite que seja realizada a transferência dos dados do 

tablet para o computador-receptor sem que tenha sido instalado previamente, através do 

computador-receptor, o aplicativo Cybertracker no tablet. Utilize um computador que seja 

seguro, onde os dados não possam ser corrompidos ou editados. 

O arquivo MDB (Microsoft Access) foi programado no software Cybertracker para 

apresentar cada um dos campos e alternativas contidas no Boletim de Informações Cadastrais 

(BIC), reproduzindo perfeitamente este formulário que anteriormente vinha sendo utilizado 

pelos técnicos da Prefeitura em modo analógico (impresso). 

 

2.3 Procedimentos para acessar o MDB e realizar a instalação do aplicativo (App) 

Cybertracker no Tablet 

 

Antes de realizar o primeiro levantamento imobiliário, conecte o tablet ao computador e 

espere o reconhecimento, em seguida: 

Acesse o software Cybertracker > menu File > Open Database; 

Localize a pasta criada anteriormente e abra o arquivo “BIC-

Botuvera_20140114.MDB” (fornecido pela equipe do GeoLab); 

Com o Cybertracker aberto, clique no menu View > Applications; 

 

 
Figura 2 - Telas (screen) customizadas na opção Applications. 

Fonte: Projeto Botuverá/GeoLab, 2014. 

 

Clique em “Install to mobile device” e aguarde alguns segundos; 
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Figura 3 – Procedimento para instalação do aplicativo Cybertracker no tablet. 

Fonte: Projeto Botuverá/GeoLab, 2014. 

 

2.4 Inserindo informações cadastrais no tablet 

 

As telas do Cybertracker no tablet foram customizadas de acordo com o Boletim de 

Informações Cadastras (BIC) de Botuverá. A Figura 4 apresenta a tela inicial do BIC no 

tablet. 

 
Figura 4 – Tela inicial do BIC no aplicativo Cybertracker. 

Fonte: Projeto Botuverá/GeoLab, 2014. 

 

Selecione a tela em branco Tap to edit > digite o Código da Unidade > OK > avance 

pela seta. Repita este mesmo processo para as telas seguintes: 

 Rua; 

 Número; 

 Proprietário ou detentor; 

 CPF/CNPJ; 

 

Nas próximas telas as informações são alternativas únicas, ou seja, apenas uma opção 

será selecionada > passando para a próxima opção com a seta > seguirá o mesmo processo nas 

telas posteriores: 

 Situação do Terreno; 

 Utilização do Imóvel; 

 Pedologia; 

 Calçada; 

 Topografia;  

 Murado;  

 Patrimônio;  

 Uso do Imóvel;  

 Ocupação; 

 Característica; 

 Revestimento Externo; 

 Piso;  

 Forro;  

 Cobertura;  

 Instalação Sanitária;  

 Posição;  

 Tipo de Construção;  

 Estrutura;  

 Estado da Construção;  

 Instalação Elétrica; 

 Situação da Construção;  

 Fachada;  

 Situação do Imóvel; 

 Tipo de pavimento; 
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Para finalizar o questionário selecione as alternativas de múltipla escolha, ou seja, 

selecione mais de uma opção, caso seja necessário:  

 Serviços Urbanos no LOGRADOURO; 

 Serviços Urbanos na UNIDADE. 

 

Obs.: Caso seja registrada alguma alternativa incorreta, basta voltar à tela anterior, 

pressionando a seta apontando para a esquerda (<). 

 

Na tela “Registro Fotográfico” (Figura 5) faça uma foto da unidade em cadastramento. 

Selecione a tela em branco Tap to capture > a câmera do Tablet será iniciada 

automaticamente > selecione o ícone de uma câmera fotográfica para capturar a foto > 

enquadre o imóvel corretamente > SALVAR > selecione o ícone com uma seta indicativa 

para baixo (destacado em vermelho na imagem a seguir); 

 
Figura 5: Tela de registro fotográfico. 

Fonte: Projeto Botuverá/GeoLab, 2014. 

 

A tela seguinte (Figura 6) ativará automaticamente o “GPS” > aguarde alguns instantes 

para que o GPS localize os satélites, até chegar em 100% (destacado em vermelho) > a tela 

passará automaticamente para a tela inicial e todos os dados estarão salvos. Deve-se 

necessariamente aguardar que o GPS colete o ponto. 

 
Figura 6: Tela para registro de localização. 

Fonte: Projeto Botuverá/GeoLab, 2014. 
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Obs. 1: Caso sejam constatadas obstruções (por exemplo, telhado, copa de árvore, 

edifícios próximos) acima ou próximo ao Tablet, o GPS poderá não receber apropriadamente 

o sinal oriundo dos satélites, devendo assim o cadastrador afastar-se da unidade imobiliária 

em cadastramento até um local que receba o sinal dos satélites, mas com o cuidado de buscar 

manter a menor distância possível da unidade imobiliária.   

Obs. 2: Caso você queira visualizar os dados que já foram coletados, pressione o círculo 

preto no canto inferior esquerdo. Nesta opção irão aparecer duas abas de visualização: Geral 

(All sightings), onde se vê todos os dados que foram coletados; e o detalhamento de um 

registro salvo, o qual estará disponível para a visualização ao selecionar um registro na aba 

All sightings > selecionar Active. 

 

Clique no menu View novamente > escolha a opção Reports (Figura7); 

 
Figura 7: Tela do programa CyberTracker no computador. 

Fonte: Projeto Botuverá/GeoLab, 2014. 

 

Caso apareçam automaticamente os dados coletados na tela, verifique a data desses 

registros e confira se são os dados gerados mais recentemente, se for pode finalizar o 

programa; 

Caso os registros não apareçam em tela, ou apareçam registros que não conferem com a 

data de coleta dos dados (registro de datas anteriores) > clique no menu File no canto superior 

esquerdo e depois > em Get data from connected device (ou tecle F7) (Figura 8). Aguarde 

alguns segundos até que a tela se atualize com novos dados. 
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Figura 8: Tela do programa CyberTracker no computador, opção Get data from connected 

device. 

Fonte: Projeto Botuverá/GeoLab, 2014. 

 

 Feche o aplicativo (os dados estarão salvos). 

 

Obs: Este procedimento irá deletar os registros automaticamente da memória do Tablet, 

porém serão preservados no cartão microSD como backup (cópia) de segurança; 

 

 

2.5 Procedimentos para descarregar os dados coletados no computador  

 

Após proceder a coleta de dados, conecte um dos tablets ao computador e repita os 

procedimentos do item 0 e 0 e, em seguida:  

Clique na aba “Reports”, caso ela não esteja selecionada. Os registros da coleta de 

dados deverão aparecer. É importante verificar a data dos registros e conferir se realmente 

foram baixados; 

Caso os registros não aparecerem em tela, clique no menu File > Get data from 

connected device (ou tecle F7) e aguarde alguns segundos até que a tela se atualize com novos 

dados; 

Os dados estarão salvos no arquivo MDB e serão automaticamente apagados da 

memória do tablet, porém, estarão preservados no cartão MicroSD como backup de 

segurança. 

 

3. RESULTADOS E DISCUSSÃO 

 

Após a obtenção dos dados do levantamento cadastral imobiliário na área urbana do 

município de Botuverá, por meio do uso do aplicativo Cybertracker e das visitas in loco as 

edificações, foi possível gerar uma base de dados cadastrais no formato MDB (Microsoft 

Access - alfanumérica) e outra no formato shapefile (ESRI) - gráfica.  

A utilização conjunta do Cybertracker e das ferramentas disponíveis no Sistema de 

Informações Geográficas – SIG/ArcGIS permitiram disponibilizar aos técnicos da prefeitura 

de Botuverá uma nova percepção sobre o município, bem como identificar e quantificar 
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espacialmente o vetor crescimento, concentrações estratificadas de potencial desenvolvimento 

econômico, correlação com áreas de risco e ocupação imobiliária entre outros. 

Conforme exposto anteriormente, o levantamento compreendeu a zona urbana do 

município e, nesta primeira etapa do projeto abrangeu exclusivamente as unidades 

imobiliárias que ainda não estavam registradas no banco de dados da Prefeitura, o que 

representou a entrada de 551 novas unidades (Figura 9). 

 

 
Figura 9 - Localização dos imóveis cadastrados. Fonte: Elaboração dos autores, a partir de 

dados da SDS (2010), IBGE (2013) e do levantamento imobiliário. 

A equipe da Prefeitura visitou todas as unidades imobiliárias da área urbana de 

Botuverá e atualizou os respectivos dados cadastrais. Em especial fez a atualização das 551 

novas unidades imobiliárias por meio do aplicativo Cybertracker que correspondeu ao (BIC) e 

que ainda incluiu: a) captura das coordenadas geográficas com o GPS; e b) registro de 

fotografias da faixada das unidades, conforme exemplifica a Figura 10. 
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Figura 10 – Exemplo de registro fotográfico realizado durante o levantamento das unidades 

imobiliárias de Botuverá por meio do aplicativo Cybertracker. 

Durante o procedimento metodológico visando a execução do levantamento imobiliário 

foram identificados alguns problemas no descarregamento dos dados no computador - 

servidor de dados na Prefeitura. Efetivamente, ao proceder ao descarregamento dos dados 

(tecla F7) através do software Cybertracker, constatou-se que os dados do levantamento não 

estavam disponíveis na tela Reports (relatórios). Após a realização de uma pesquisa detalhada 

nas pastas gravadas pelo Cybertracker no computador, verificou-se que os dados foram salvos 

nas pastas Backup e Orphans, localizadas no seguinte endereço padrão: 

C:\Users\NomedoPC\Documents\Cybertracker\System.  

O Cybertracker foi programado para efetivar o intercâmbio dos dados exclusivamente 

entre versões equivalentes, razão pela qual as tentativas de descarregamento dos dados não 

resultaram no funcionamento correto do sistema, derivando-se os dados para as pastas 

supracitadas (Backup e Orphans). 

Outra dificuldade encontrada no decorrer do desenvolvimento do projeto também 

relaciona-se ao armazenamento dos dados. Conforme indica o manual do Cybertracker 

(disponível no site da organização), sempre que os dados contidos em um aparelho móvel 

(seja ele smartphone, tablet ou GPS) forem descarregados no computador, um backup 

automático para o cartão de memória (no caso do tablet, um MiniSD) é feito pelo aplicativo 

Cybertracker. No entanto, até o momento não sabe-se o porquê a cópia automática (backup) 

não foi transferida com êxito.  

 

3 CONSIDERAÇÕES FINAIS 

 

A partir da realização do levantamento cadastral imobiliário no município de 

Botuverá/SC comprovou-se, por meio da utilização dos Cybertracker, a viabilidade de uso 

caracterizando em um baixo custo para implantação por prefeituras municipais. 

Ressalta-se que o Cybertracker instalado em um tablet torna viável e ergonômico a 

geração de um banco de dados georreferenciado associando as fotografias de fachadas dos 

imóveis. A integração do BIC, as fotografias e as coordenadas geográficas foram as 

características de maior destaque no processo de desenvolvimento do projeto, a qual evidencia 

o potencial de replicação desta metodologia a outras prefeituras de pequeno porte. A 
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reprodução do Boletim de Informações Cadastrais nos tablets, assim como a facilidade para 

se customizar e operacionalizar o software e o aplicativo Cybertracker também constituíram 

pontos positivos a este recurso tecnológico gratuito.  

Por fim, torna-se fundamental a capacitação de técnicos das prefeituras brasileiras no 

domínio de geotecnologias, banco de dados e manipulação de documentos cartográficos em 

meio digital.  
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